
Drag And File
Drag And File streamlines and simplifies the work of managing files under Windows 95 and Windows NT. 
It offers several unique functions, such as a directory finder, a duplicate file finder and a DOS command 
utility.
Drag And File works at several levels of sophistication and integrates with other management and utility 
programs. The result is an uncommon degree of flexibility: Drag And File can be configured to meet your 
needs, your working style, and your experience. When you need more, Drag And File delivers. 
Unlike most other Windows file managers, Drag And File allows you to highlight individual files and tag 
multiple files, which makes possible batch operations on non-contiguous groups of files. 
Drag And File offers a broad range of file management tools:

· Drag-and-drop file move, copy, and delete

· Viewing of all text and most graphics files

· Tree and branch batch operations on all files

· Single click execution of most frequent tasks from a toolbar, including viewing

· Separate windows for each drive

· Full configurable hot key control for hands-on keyboard    execution

· Formatting and diskcopying for floppy diskettes

· Full access to the Windows 95 Shell functions like creating shortcuts, Quick View and file 
properties.

· Filter Sets for quick display of special groups of files

· Directory synchronization

Main window



Drag And File displays a window complete with toolbar and menu choices for each drive selected. You 
may open up to 12 drive windows simultaneously. 
The entire program can be run from a single small Drivebar which floats unobtrusively on your screen. 
The Drivebar makes complete directory and file information just a mouse click away.

Drivebar

Drag And File includes an Uninstaller to remove the program and changes made during installation. 
Note:    Microsoft Windows' file-handling requirements may make it necessary for you to delete the 
uninstaller file itself. 



Drag And File Gold
Drag And File Gold is a special version of Drag And File that also includes our archive management 
program, Drag And Zip.    When Drag And File is combined with Drag And Zip, you can easily manage ZIP,
GZ, and TAR files completely within Drag And File.    

ZIP,    GZ and TAR files will appear as folders in the directory pane of Drag And File.    The color of these 
folders is blue as compared to yellow for actual directories to make the difference easily noticeable to the 
user.    Just like with a regular folder, you can highlight an archive in the directory pane and the contents of
the file will be listed in the file pane.
Extracting files from the archive is just like copying from a directory.    You tag the files that you want to 
extract and choose copy or move.    The files will be extracted to the desired directory.

Drag And File Gold has an additional menu in it’s main menu bar.    This menu called “Archive” has 
commands to create an archive, virus scan an archive and “Check Out” an archive.    Check Out will 
extract the files to a temporary directory and allow you to “check them out”.    You will be given the option 
to delete the check out files or make the check out directory permanent when you either close Drag And 
File or check out a new file.

The Create Archive “Zip”, Virus Scan and Check Out commands can also be put on Drag And Files 
toolbar.

These commands are also available when right clicking on the file pane.    Because of limitations in the 
Windows 95 shell context menus, some options are not available for files in an archive.    These options, 
Create Short Cut, and dragging and doping to the desktop cannot be performed on files in an archive.    
You will have to first extract the files to a real directory before being able to perform these actions.



User Help
Drag And File is designed to present options and procedures clearly. The window components, including 
icons, graphic and text buttons, and directory tree displays, make evident what to do and how to do it.
Along with ease of use and the ordinary features of file management, Drag And File offers an unusual 
degree of sophistication. 

Canyon Software is committed to producing software that is useful and productive. To help users make 
full use of Drag And File, Canyon Software maintains a technical help line for registered users from 8:30 
AM to 5:30 PM Pacific Time.

Phone (415) 453-9779
Fax (415) 453-6195
BBS (415) 453-4289
CompuServe Go CANYON
America On Line DanBCan
Internet support@canyonsw.com



Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to adjust 
several aspects of the program's performance and display.
To change fonts:

1. Select Fonts from the Options menu.

The Fonts dialog box displays. Available fonts are those which are installed under Windows, or 
under a type manager working with Windows.

Font options dialog box

2. Make whatever changes you wish and click OK.

The changes take effect immediately and remain when you exit the program.
To change Settings:

1. Select Settings from the Options menu.

The Settings dialog box displays.    The Settings dialog box has three pages for configuring Drag 
And File Options.    In addition if you have our programs Drag And Zip or Drag And View Gold 
installed, there will be pages for configuring them too.      You select a page by clicking the mouse 
on one of the tabs at the top.    The first page is for general settings.



General    Settings page

2. Enter your choices for warnings, multiple windows operations and window appearance, file delete
and editor.

Overwrite Warnings. When enabled, these warnings appear when the files you are copying 
or moving are about to overwrite files of the same name.      These warnings can always be 
overridden at copy or move time.

File Delete. When checked, files deleted in Drag And File will be send to the RECYCLE BIN.  
When not checked, you will have to use an undelete program to recover deleted files.    This 
option may not work on earlier builds of Windows 95.    We know that it works on bulds 474 
and greater.    This option is not available when running under Windows NT.

Multiple Window Operations. Drag And File lets you perform operations on tagged files in 
more than one window. These choices allow you to specify which operations you would like to
perform in multiple windows.

When Copy from multiple windows is checked, Drag And File will perform all file copy 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When Move from multiple windows is checked, Drag And File will perform all file move 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When View files from multiple windows is checked, and you choose the view files option 
from the Drag And File tool bar or the "Actions" menu, Drag And File will view the highlighted 
and tagged files from all open Drag And File windows.

When View directories from multiple windows is checked, and you choose the view 
directories option from the Drag And File tool bar or the "Actions" menu, Drag And File will 



open up a view window with the listing of all the files in the highlighted and tagged directories 
from all open Drag And File windows.

When Drag and drop from multiple windows is checked, all drag and drop operations to 
other programs include the tagged files or highlighted file from all Drag And File windows.    
Drag And Drop operations to toolbar buttons will depend on the configuration for the action of 
the particular button.    For example, if you have Drag And File configured to copy from only 
the active window, dragging files to the copy button will only work on the active window no 
matter what you have configured for drag and drop.

When Zip file from multiple windows is checked and you click on the zip button on the 
toolbar, the highlighted file or the tagged files in all the open Drag And File windows will be 
put in the resulting Zip file.    This will only work with Canyon Software’s program Drag And 
Zip.

Save Window Layout:    Checking this option will have Drag And File save the location and 
the current directories of all open Drag And File windows when you exit Drag And File.    
Running Drag And File again will open all the windows of the previous session and have them
displaying the same directories as the previous session.    To save the layout of multiple Drag 
And File windows exit with “File/Close All DF Windows”.    

Window Appearance: These choices follow the pattern for Microsoft Windows: cascaded 
windows are overlapped slightly, and tiled windows are fully visible.

Editor:    Enter your editor of choice in this field and you can edit a highlighted file when you 
choose the edit file option.

Show Archives as Folders:  This option will be visible only if you have Drag And File Gold 
installed.    With Drag And File Gold, Files with the extension ZIP, GZ and TAR will appear as 
blue folders on the directory tree.    Highlighting these files will show the contents of the folder 
in the file pane.    Extracting files from the archives are as easy as performing a copy or move.
This option will be checked by default.    If you don’t want files listed this way, uncheck it.



 Drives Page

3. In the drives page you can configure the drives that are available to Drag And File.    This is 
particularly useful on networks where you might want to limit the drives available to different 
users.    The settings in this dialog box will be reflected in both Drag And File and the Drag And 
File Drive Bar.

Select the drives that you want to have available.    To make drive selection easier, there are 
check boxes where you can turn on or off the different drive types.    Drives that have been 
selected will be displayed below the drive list box.



DOS Command Page

4.    You can turn on Drag And File’s DOS Command Line by choosing Show DOS Command Line 
from the Options menu.    In this page you can set the DOS command Line defaults.

DOS In Window:    You can run most DOS commands with the SmilerShell and can choose to 
have these commands run full screen or in a DOS window.    The default is to run the commands 
in a DOS Window.

Inactive DOS Windows Stay Visible:    This options determines whether the DOS windows will 
stay around or close after DOS commands are run.    If you choose to have the DOS windows 
stay around you can easily close them all at once by pressing Ctrl+Shift+K from the keyboard.

Insert Mode: Use this to toggle between Insert or Overtype mode

If you have Drag And View installed you will have a Drag And View Tab.



Drag And View Page

1. View Highlighted File Automatically If this option is turned on, Drag And View will display each 
file as it is highlighted in the file manager.    It will not open a Drag And View window if one is not 
already running.    For that you need the next option.

2. Open View Window if Necessary This option works in conjunction with the previous one.    This 
will open a Drag And View window to view files if one isn’t already open.

3. Bring View Window To Top This option is also    designed to work in conjunction with the option 
“View Highlighted File Automatically”.    When this option is checked, the view window will always 
come to the top when a new file is highlighted and consequently displayed.    If it is not checked, 
the view window will stay where it currently is.

4 Hide Icon This option will only be available when running Drag and View under Windows NT and 
Program Manager.    The Drag And View Icon will normally be showing on the screen when it is 
running.    Some users have requested that the icon be hidden and that they only use the 
FMLaunch menu to view files.    With this option you can make Drag And View’s icon not show 
when it is running.    After checking this option you will have to quit Drag And View and run it again
to have it activated.

5. Icon Caption This option will only be available when running Drag and View under Windows NT 
and Program Manager.    Many users have requested that they be able to modify the caption of 



Drag And View icon.    In this field you can fill in whatever caption you want it to have.    If you 
leave it blank, Windows will put a blank line in reverse video under the icon.

If you are running Drag And File Gold you will have a Drag And Zip Tab.

Drag And Zip Page

1. Hide Icon Under Windows NT with Program Manager, Drag And Zip runs as an icon at the lower 
left of you screen.    This option will hide the icon from view.    Under Windows 95, it won’t do 
anything.

2. Icon Always Visible Checking this option will make Drag And Zip's icon visible at all times.    This
is not necessary in Windows 95 or if you are running Drag And Zip with Fileman Launcher, as 
Fileman Launcher will always uncover DZ's icon when you are working in your file manager.

3. Icon Stays Where Last Put Checking this option will have Drag And Zip remember the position 
of its icon when you last ran it.    This is not necessary if you are running DZ with Fileman 
Launcher or if you’re running Drag And Zip under Windows 95.

4. PKZIP Version 2 or Greater It's important that this option be checked if you are running with 
PKZIP version 2.04, and that it not be checked if you are running with PKZIP version 1.1.    That 
way Drag And Zip can pass the proper commands to PKZIP when it is running it.    No other 
versions of PKZIP are currently supported.    When you choose your PKZIP directory, Drag And 
Zip will try to determine this automatically.

5. Output Directory You have two choices of the default output directory that Drag And Zip will 
enter into the zip dialogs.    One is the current directory, which is the directory that you dragged 
the files from.    The other is the directory that you used the last time that you used Drag And Zip.

6. PKZIP Location This should contain the directory where your copies of PKZIP and PKUNZIP 



are.    It is not necessary to fill this out if you are using the built-in zipping and unzipping.    You will 
need to fill this out if you want to make self-extracting zip files and ZIP2EXE is not on your path.    
When this field is active, you can use the browse button to find the PKZIP directory.

7. LHA Location This should contain the directory where your copy of LHA.EXE is. When this field 
is active, you can use the browse button to find the LHA directory.

1. Path For Temporary Files Drag And Zip normally creates temporary files and temporary 
directories in it home directory.    This may not be possible if you are running Drag And Zip from a 
network and you don’t have write access to the DZ home directory.    For conditions like this, you 
can specify a directory where Drag And Zip can store temporary files.

2. WWW Browser Zip View has been made to work with many World Wide Web browsers.    Make 
sure you have the full path including the file name of the browser entered in this field.    If it is, Zip 
View will run automatically whenever you bring a GZ, ZIP, TAR or LZH file from the net. 

3. Anti Virus Program By default, Drag And Zip will use its built-in virus scanning program.    
However you can also have it run your copy of Mc Afee Scan 95 or Norton Anti Virus.    Choose 
the program that you want to run from the combo box.



Configure Toolbar
Drag And File's button toolbar is very easily modified allowing you to add and delete different buttons.    
Programs can also be added to toolbar buttons.    All toolbar buttons can be configured to user Alt or Ctrl 
key combinations as hot keys.    Alt hot keys are shown in the lower right of the button as black on gray.    
Ctrl hot keys are shown as white on black.    There is also an option to completely hide the toolbar.    If the 
toolbar is hidden, the configured hot keys are still active.
To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.

The Toolbar Customize dialog appears:

Toolbar Customize dialog

In the list box on the left appear the available button choices.    The top two entries are SEPARATOR 
and NEW PROGRAM.    SEPARATOR adds a space between two buttons.    NEW PROGRAM allows 
you to install a program as a button choice.    In the list box on the right appear the buttons that are 
currently part of the toolbar along with their hot keys.    

To add a new button
1 Select the position in the Toolbar buttons list box where you want the button to appear.    The new 

button will appear before the selected button.    You can also drag buttons in the Toolbar buttons 
list box to modify their position.

2. Select the button that you want to add from the Available buttons list box.    You can also choose 
SEPARATOR or NEW PROGRAM.    If a command button is already in the Toolbar buttons list 
box, it won't be in the Available buttons list.

3. Choose Add or drag the button to the right hand list box.    The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.    Click on Remove or 
drag the button to the left hand list box.    The button will be removed.

To add a program
1. Select NEW PROGRAM and choose Add.    The Add Program dialog will appear.



Add Program dialog box

2. Browse through the directories and files and pick the program that you want to associate with the 
button.    If you want the file that's currently highlighted to be launched with the program check the
Launch Highlighted File With Program box.    When the mouse cursor is over any of the toolbar
buttons, a little window will come up saying what the button does.    You can enter a custom 
button description in the Button Description field.    If no description is entered, the program 
name will be used.

3. Choose OK and the button will be added to the Toolbar buttons list box.    If the program has an 
embedded icon like most Windows programs, that icon will be placed on the button.

To modify a program button
1. Highlight the button in the Toolbar buttons list box.    Choose the Program button and the Add 

Program dialog will appear.    Follow the directions for adding a program.
To add a filter set

1. Select    the Filter Set button and then click on the Add button.    The Add Filter Set dialog will 
appear.



Add Filter dialog box

1. The available filters are shown in a list box.    When you highlight a particular filter, that filter’s file 
spec and other parameters are shown below.

1. Choose OK and a filter set button will be added to the Toolbar buttons list box.    The name of the 
filter set will appear in the tool tip window when you place the cursor over the button.

To add or change a button hot key
1. Highlight the button whose hot key you want to change or add.    Select the letter of the hot key 

that you want to use from the drop down list box in the lower right of the Customize Toolbar dialog
box.    Choose Alt or Ctrl if you want the hot key to use the Alt key or the Ctrl key.    

When you are finished making changes to the toolbar, choose OK.    All changes will be saved and 
windows updated.    If you choose a hotkey that is already in use, you will be warned before saving the 
new hot key.



About the Drivebar
Though small and unobtrusive, the Drag And File Drivebar can provide access to all your Drag And File 
functions.
The Drivebar consists of a floating bar containing buttons which represent your drives, removable and 
fixed drives, local and networked, and a control bar. Click on a drive button to open a new drive window. 
Click on the control bar to open a menu with choices to control the Drivebar display and to close all open 
Drag And File windows.

Drivebar

The DF Drivebar normally floats in the foreground, above whatever application is current.



Using the Drivebar
To activate the Drivebar, open the Drag And File group window from Program Manager and click on the 
DF Drivebar icon. 

Drivebar icon



Configuring the Drivebar
The    Drivebar can be altered to fit your needs. 
To configure the Drivebar:

1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.

The control menu appears.

Drivebar control menu

2. Click on Display Vertically (or Display Horizontally) to select the configuration other 
than the one currently in effect.

3. Click on Always Visible to make the Drivebar appear on top of other programs.

4. Click on Close All Drag And File Windows to close all open Drag And File drive windows, 
but leave the Drivebar icon visible.

5. Click on other choices as needed to Move, Close, open a Help window, or to see information 
about the Drivebar.



Drag And File Main Window
The Drag And File window is divided into several functional and information sections. Drag And File can 
open up to twelve windows simultaneously.

Drag And File main window

The menu bar contains drop down menus. They are accessible with a mouse or directly from the 
keyboard by using the Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of directories on this 
drive, the space remaining on the drive, the    files in the selected directory, and their total size.
The drive buttons allow you to choose which drive information the open window displays. Double clicking 
on the icon of the currently displayed drive opens a second window displaying that drive.
The lower half of the window is divided into two panes: information in the left pane concerns directories, 
and information about files appears in the right pane.



Choosing files and directories
Drag And File, slightly differently from Microsoft Windows File Manager,    and Windows 95 Explorer.

Drag And File marks files and directories by highlighting, tagging, and dotting.

· Highlight files and directories by left clicking on them with the mouse, or by using the arrow keys 
to move the highlight bar up or down over a listing. Only one directory or file can be highlighted at
a time. Operations like Copy or Move can be performed on a highlighted file by clicking the 
appropriate tool, or by using drop down menus or keyboard shortcut keys. If any files are tagged, 
highlighting is ignored.

· Tag and untag files or directories by several methods:

· Ctrl+Left Mouse Button will tag or untag a file.    A tagged file has a red arrow to its left.

· Ctrl+Left Arrow or Slash tag all files or directories

· Right arrow to tag; left arrow to untag.    ( This method is not available when viewing filenames 
only )

· Spacebar and Ctrl-Right click to toggle tagging on or off.

· Ctrl+Right Arrow or Ctrl+Slash untag all files or directories

· Dots mark files which have been copied. Dotted files may be reselected as a group for other 
operations.



Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include information 
about shortcut key combinations to activate commands from the keyboard.
Drag And File includes in its menu bar extensions¾drop down menus inserted in the File Manager's menu
bar by utility and other programs.



Drive bar
The drive bar includes buttons that represent all accessible drives.    Click on a drive button to change to 
that particular drive.    Double click on a drive button to open a new Drag And File window for that drive.    
Additionally, files can be dragged to the drive buttons for copying or moving.    In Windows 95 you can 
right click on a drive button to bring up a context menu. From this context menu you can access the drives
sharing, format the drive, create a shortcut or access the drives properties.



Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.



Directory Pane
The directory pane displays, in a tree format, all directories and subdirectories of the currently selected 
drive.



File Pane
The file pane displays a list of the files and their attributes contained within the currently selected directory
or subdirectory.    If you are viewing all file details (the default view) there will be a Caption Bar over the 
file listing.

You can drag the boarders of some of the sections to resize the colums.    When you click on the heading 
buttons you will sort the file list in the order of the button legend.    One click will sort ascending.    The 
second click will sort descending.



Type to File/Directory function
To locate a specific directory or file, when the appropriate pane is active, start typing the name of the 
directory or file. Your typing appears in a small window that opens over the directory count in the lower left
corner of the window, beneath the directory pane. As you type, the highlight bar will move to the directory 
or file which most closely approximates your typing.



Drag and drop functions
Drag And File uses all the mouse conventions associated with Microsoft Windows programs.
When you drag and drop files and directories with the left mouse button to a directory or drive button, a 
dialog box opens. Using options in the dialog box you can specify a Copy or Move operation, the name of 
the file or directory, and use a browse feature to specify the path.
When "Drag and drop from multiple windows" is turned on in the settings dialog, all drag and drop 
operations will use the highlighted or tagged files in all open Drag And File windows.
Files or directories can also be dragged to toolbar buttons.

When you drag and drop files and directories with the right mouse button under Windows 95, a context 
menu will popup allowing you to copy or move the files or creeate a shortcut to the files.    



Toolbar functions
Drag And File's toolbar contains buttons which make the most common file management tasks easily 
accessible.    Functions and programs can be added to or deleted from the toolbar by choosing Options\
Modify Toolbar.



Using The Keyboard
Drag And File allows you to access most functions directly from the keyboard as well as use the mouse to
select functions from a drop down menu.    All buttons can have Alt or Ctrl key combinations assigned to 
them.



File Menu
Use commands in the File menu to perform the most common functions used to manage your files and 
directories.    If the command has a button associated with it, then this command can be put on the 
toolbar.



Copy Shortcut: F8

The copy command copies directories or files depending on which pane is active.
If you are copying a single file, the file may be renamed as part of a Copy operation, if you type the full 
pathname of the new file in the text field in the Copy/Move dialog box.    If you are copying more than one 
file and enter a path name that doesn't exist, Drag And File will assume that you want to create the new 
directory and give you the option to create it.    
The bottom of the Copy/Move dialog box contains additional options:

· Use the browse button to easily choose destination directory.

· Perform the operation on just the current window or multiple open windows.

· Turn on and off overwrite options.

· Change the copy operation to move and vice-versa.

· If the operation is being performed on a directory with branches, the operation can also be 
performed on the entire branch.

If you are running Drag And File Gold, the same action can be performed on Zip, GZ or TAR files.    Just 
tag the files that you want to extract and the copy command will extract the files to the desired directory.



Move Shortcut: F7

The move command moves a file or directory depending on which pane is active.    All the options in the 
copy dialog also exist for Move

If you are running Drag And File Gold, the same action can be performed on Zip, GZ or TAR files.    Just 
tag the files that you want to extract and the copy command will extract the files to the desired directory.



Delete Shortcut: Del

Use the Delete command to delete a single highlighted or one or more tagged files or directories. 
The dialog box which appears when you invoke this command is the only confirmation you will see of this 
operation.
In the more recent builds of Windows 95 (470) and later, the default is for deleted files to go to the 
Recycle Bin.    This can be changed by going into the “Options/Settings” dialog.

If you are running Drag And File Gold, the deleting can be performed on Zip, GZ or TAR files.    Just tag 
the files that you want to delete and the delete command will remove the files from the archive.    They 
files will not be sent to the recycle bin.



Rename

Use the rename command to rename a file or directory.    If multiple files are selected they can be 
renamed en masse with wild cards.



Launch Shortcut: Enter

Use the Launch command to launch the highlighted file.    If the highlighted file is a data file this command 
will run the associated program with the data file.    If the highlighted file is a program, then the program 
will be run.
If no association exists for the type of file you have selected, Drag And File opens a dialog box in which 
you may record an association for this type of file.



Make Directory

Use the Make Directory command to create a new directory as a subdirectory of the currently highlighted 
directory.



Find Files

The Find Files command searches for files in selected directories or drives.    If you wish to search for a 
file in selected directories, select the directories that you want to search.    You can do this in multiple Drag
And File windows.    Then choose "Find" and enter the filename that you want to search for. Wild cards 
are permitted.    Alternately, you can also choose to search for the file in the current drive or multiple 
drives.

The find dialog allows you to search for files for files that certain text or match a particular file attribute or 
both.

The find command only searches for actual files and will not search the contents of archives.



File Attributes Shortcut: Alt+Enter

Use the File Attributes command to open the Attributes dialog box.

File attributes dialog box

Use choices in this box to assign or remove attributes which are useful in managing files, and which the 
operating system sometimes assigns    automatically. MS-DOSâ uses four attributes and a null condition:

· Archive

· Read Only

· System

· Hidden

· Normal Attribute
The Archive attribute is assigned by DOS to a file which has changed after being backed up.
Read-only prevents a file from being edited or deleted.
System files, designated by DOS, contain information about hardware and system configuration. They 
cannot normally be deleted or changed.
Hidden prevents a file from being included in a DOS directory listing. Drag and File, however, does 
include hidden files in its display of files in a directory.    
Files with no attribute options checked are considered Normal Attribute.



Associate
Use the Associate command to associate a program file with a file of a particular type identified by its 
three-letter extension.
For example, files ending in .TXT are normally text files and would be associated with an editor such as 
Windows Notepad or Norton's Desktop Editor.
To record an association:

1. Click on the Associate option from the File menu.

2. Choose the program file from those displayed.

-OR-

Click on Browse to select a program file from another directory.

3. Click OK to close the window and record your choices.



Multi Associate
Use the Multi Associate command to associate more than one program with filenames of a specified 
extension. If you want to choose among different word processors to edit files with a .TXT extension, for 
example, you would use this command to list those word processors.
When you double click on a file with such an extension, Drag And File opens a dialog box which allows 
you to choose one of the designated programs associated with this filename extension.
To record multiple associations:

1. Click on the Multi Associate option from the File menu.

2. Type the full pathname (including drive, directory, and filename) of the new program.

-OR-

Click on Browse to select a program file from another directory.

3. Click Add to add the program to those displayed in the current associations window.

4. Click OK to close the window and record your choices.



List All Files Shortcut: Ctrl+Enter
Use the List All Files command to open a files-only window which contains an alpha-ordered list of all files
on the drives you select.
To list all files:

1. Select this command to open the drive selection window.

2. Select the drives containing the files you wish to list. 

A click of the left button of the mouse toggles drive selection.

3. Click OK to open the file list window.



Exit

Use the Exit command to close a Drag And File window.



Close All Drag And File Windows

Use this command to close all open Drag And File windows, including the window from which the 
command was selected.    
The DF Drivebar is not affected by this command.



Format Diskette

Use this command to format a floppy diskette. The contents of the diskette will be destroyed.    You can 
prevent this by choosing the option "Safe Format".

Format Diskette Dialog Box

The options are:

· Make Disk Bootable.    Use this option if you want to be able to start your computer from this disk.

· Quick Format.    Use this option on a diskette that has already been formatted.    This option will 
re-write the boot sector and root directory but will not reformat the diskette.

· Safe Format:    Use this option to save any existing files on the diskette.      This allows you to 
refresh the formatting of a diskette without having to destroy all the files on it.



Map Network Drive

This option will only be available when you are connected to a network. Choosing this option will bring up 
a dialog box allowing you to choose network drives to connect to.



Disconnect Network Drive

This option will only be available when you are connected to a network. Choosing this option will bring up 
a dialog box allowing you to disconnect from any connected network drives.



Network Neighborhood

This option will only be available when you are connected to a network. Choosing this option will bring up 
a the Windows 95 Network Neighborhood Window



Sort by Extension Shortcut: Ctrl+Shift+E

The by Extension command sorts files by the three-letter filename extension, in alpha order of extension, 
and by alpha order within each group of files of the same extension.    Options are available to sort in 
ascending or descending order.    Sorting by extension can also be done by clicking on “Type” on the 
heading bar.



Sort by Filename Shortcut: Ctrl+Shift+F

The by Filename command sorts the file list by filename in alpha order. Options are available to sort in 
ascending or descending order.    Sorting by filenmane can also be done by clicking on “Name” on the 
heading bar.



Sort by Date Shortcut: Ctrl+Shift+D

The by Date command sorts the file list in order of date.    Options are available to sort in ascending or 
descending order.    Sorting by date can also be done by clicking on “Modified” on the heading bar.



Sort by Size Shortcut: Ctrl+Shift+S

The by Size command sorts the file list by size.    Options are available to sort in ascending or descending
order.    Sorting by sizecan also be done by clicking on “Size” on the heading bar.



Unsorted Shortcut: Ctrl+Shift+U
The Unsorted command resets the file list to the original order before other sort commands were applied.



Save
The Save command saves the current sort order as the default.



Expand One Level Shortcut: Num Pad Plus
Use this command to expand the highlighted directory tree one level.    Only a tree with a "+" on it has sub
directories and can be expanded.



Expand Branch Shortcut: Num Pad Star
Use this command to expand the highlighted directory tree and show all of its sub directories.    Only a 
tree with a "+" on it has sub directories and can be expanded in this way.



Expand All Shortcut: Ctrl+Num Pad Star
Use this command to expand the entire directory tree so that all the sub directories are showing.



Collapse Branch Shortcut: Num Pad Minus
Use this command to collapse an expanded directory branch.    An expanded directory branch has a "-" on
it.



Collapse All Shortcut: Ctrl+Num Pad Minus
Use this command to collapse the entire directory tree and show only the root directory.



Fonts

Use the Fonts command to open the Font selection dialog box. This allows you to choose one of the 
Windows installed fonts to use for directory and file listings.



Settings
Use the Settings command to open the Settings dialog box. Choices in this dialog box allow you to: 

· manage overwrite warnings 

· enable operations on multiple windows 

· specify how files are deleted

· specify a text editor.

Note: For more information on changing Drag And File's settings see the section titled Setting 
Preferences.



Customize Toolbar
The toolbar in Drag And File is completely customizable.    You can add or remove over 30 different 
commands, specify any Ctrl or Alt key combination as a hot key and add any program to a toolbar button.

Note: For more information on customizing Drag And File's toolbar see the section titled Setting 
Preferences.



View All Details

Use this setting to have Drag And File show the file name, date, time, size and attributes as part of the file
listing.



View Filenames Only

Use this setting to have Drag And File show only the file name in the file listing.



Show File Icons
Drag And File can optionally display the icon associated with a file.    The icon will be displayed right 
before the filename.    Use this command to turn this option on or off.



Show Toolbar
Use this command to turn on and off the display of Drag And File's toolbar.    Any configured hot keys will 
still be active even when the toolbar isn't displayed.



Show DOS Command Line
Drag And File comes with a licensed copy of    SmilerShell the very powerful DOS command utility.    
When this option is turned on, there will be an edit field at the bottom of all Drag And File windows.    Any 
DOS command can be entered in the window.

The default for this window is insert but pressing the insert key will toggle on overstrike mode.    All DOS 
commands will be run in a window and will close when the command is finished.    If you wish to keep 
these DOS windows open when the command is finished, place an asterisk before the command.    For 
example, if you type DIR and you want the window to be kept open after DOS finishes displaying the 
directory, enter "*DIR".



Recycle Bin

Use this option to open the Recycle Bin folder.    You can drag files to this folder to delte them or undelete 
deleted files



My Computer

Use this option to open up the My Computer folder.



Control Panel

Use this option to open up the Control Panel folder.



Filter

The filter command allows you to specify file specifications and date and size criteria for which files Drag 
And File displays.    These filtering parameters can be saved as a Filter Set and easily reloaded when you 
wish to have the same filter in effect without having to specify all the parameters again.

Filter Dialog Box    File Spec Tab

The first tab allows you can specify the files specifications and attributes for the filter.    Multiple file 
specifications can be used as long as they are separated by a comma.

When Drag And File first loads it will always use the “Default”: filter for displaying files.    The Default filter 
has a file specification of “*.*” and will show directories and all file attributes.    If you wish to change this, 
choose the attributes and files specs that you want to use and click on the “Save” button.

You can also create additional Filter Sets for use with Drag And File.    To do so, choose the Filter Set tab.



Filter Dialog Box    Filter Set Tab

To create a new filter, choose the “Add” button.    You will be prompted for a filter set name and a set of file
specifications.    Multiple file specifications must be separated by commas.    In addition you can add a 
date range and size range to the filter set.    The option “Only allow files with today’s date” will always use 
the current date on your computer when displaying files.    That way you can display just the files that 
have been modified today.

To save the filter set, click on the “Save” button.    To put the filter set into effect, click on the “Apply” button
or the “OK” button. 



Filter Set
The Filter Set menu will display a listing of the filter sets that you have created in addition to the Default 
filter set.    You can make any of these sets active by choosing it from the menu.    In addition you can put 
filter sets on the toolbar.

Drag And File will have to be restarted before it will display new filter sets in the menu.



Synchronize Directories
The synchronize directory feature allows you to make sure that the files in one directory are updated with 
newer and newly created files from another directory.

To synchronize two directories first highlight the directory with that has the new and newly modified files.    
Choose Synchronize Directories from the Actions menu or click on the Synchronize Directories button.

Synchronize Directories dialog box

From the dialog box choose the directory that you want the files copied to.    You can also use the browse 
button to help you select it.    In addition to just copying the files from one directory to the other, you can 
choose to have all the sub directories synchronized too.    You can also choose to perform the 
synchronization both ways.    That way new and newer files from the target directory will also be copied to 
the source one.



Change File Date and Time

You can set the date and time of any group of selected files through this feature. Set the desired date and
time in the dialog box and choose OK.    All of the selected files will be modified.



View

The actions performed by this command depends on what Drag And File window is active.    If the 
directory pane is active, Drag And File will open a window showing the files in the selected directories.    If 
no directories are tagged, then Drag And File will will open a window with the files from the current 
directory.

When the file pane is active, Drag And File will try to open a window viewing the selected files.    If Canyon
Software’s Drag And View Gold can be found, then Drag And File will run it and have it view the selected 
files.    If Drag And View Gold cannot be found, and the platform you are running under has a Quick View 
program.    Then Drag And File will run that program.



Print Dir List / Print File List

Use the appropriate Print command to print a list of either the directory window or the file window.



Edit File

The Edit command allows you to activate the text editor specified in the Options/Settings dialog box and 
load the highlighted file into the editor.



Tag Shortcut: Right Arrow
The Tag command tags with a red arrowhead the file or directory currently highlighted.



Untag Shortcut: Left Arrow
The Untag command untags the tagged file or directory currently highlighted.



Tag All Shortcut: Ctrl+Left Arrow
The Tag All command tags all entries in the currently active window, directory or file.



Untag All Shortcut: Ctrl+Left Arrow
The Untag All command untags all tagged files or directories in the currently active window.



Tag Branch Shortcut: Ctrl+Shift+B
The Tag Branch command tags a selected directory and all of its branches.



Tag Files Shortcut: Ctrl+Shift+L

The Tag Files command opens a File specification dialog box, which allows you to specify the name, 
types, and attributes of files to be tagged.

Tag files dialog box



Retag Shortcut: Ctrl+Shift+R
The Retag command resets dots to tags. 
After a tagged group of files has been copied, the tag changes to a small red dot. Use this command to 
reset the red dot back to a tag, making possible additional actions on these files as a group. 

Note: Tagging and untagging is normally faster using the hotkeys or the mouse directly, rather than using 
a drop down menu, which adds an extra step to the process.



Create Archive

This command on the Archive menu will only be available in Drag And File Gold.    Use this command to 
create Zip or LHZ files.



Virus Scan Archive

This command on the Archive menu will only be available in Drag And File Gold.    Use this command to 
scan a Zip, GZ or TAR file for possible viruses.



Check Out Archive

This command on the Archive menu will only be available in Drag And File Gold.    Use this command to 
temporarily extract files from a ZIP, GZ or TAR file to “Check them out”.    When you finished you can 
either save the files to a permanent directory or delete them.



New Window

Use the New Window command to open a new Drag And File window.    The drive displayed in the current
window appears in the new window. 



Cascade Shortcut: Shift+F5

Use the Cascade command to arrange the open Drag And File windows on the screen in an overlapping 
manner so the title bars are visible.



Tile Horizontally Shortcut: Ctrl+Shift+F4

Use the Tile Horizontally command to arrange the open Drag And File windows on the screen so that 
each is wholly visible. This command will tile them horizontally.



Tile Vertically Shortcut: Shift+F4

Use the Tile Vertically command to arrange the open Drag And File windows on the screen so that each is
wholly visible. This command will tile them vertically.



Refresh Drive Shortcut: F5
Use the Refresh drive command to update the listing of directories in the left pane of the window.



Refresh Files Shortcut: F4
Use the Refresh files command to update the listing of files in the right pane of the window.



Working From Multiple Windows
Drag And File allows you to perform operations on files in more than one Drag And File window in a single
operation.    These options are all off by default but they can easily be turned on from the Options/Settings
dialog box.    The operations that you can perform from multiple windows are:

· Copy

· Move

· View Files or Directories

· Compress Files

· Drag And Drop Files or Directories
When any of these operations are turned on the operation will be performed on the tagged or highlighted 
files in all the open Drag And File windows.    As a safety measure, if a copying or moving operation 
results on writing a file on top of itself, the action will not be performed.
Drag and drop from multiple windows will only work when dragging the files or directories to another 
application like Drag And View Gold or Drag And Zip.    If the files are dragged to a toolbar command, 
Drag And File will use the configuration for the command rather than drag and drop.    For example, if you 
have drag and drop from multiple windows turned on but copying from multiple windows turned off and 
you drag files to the copy button, copying will only be performed on the active Drag And File window.



Drag And File Secondary Window
Besides the main Drag And File windows, Drag And File allows you to work with files from more than one 
directory or drive through the Drag And File secondary window.



Viewing Files in Tagged Directories
 The simplest way to bring up the Drag And File secondary window is to tag a number of directories and 
while still keeping the focus on the directory pane, click on the view button.    The files from the tagged 
directories will be read and listed in the secondary window.    If you turned on view directories from 
multiple windows, you can do this from more than one Drag And File main window.

Drag And File Secondary Window

The listing in the secondary window is very similar to the listing in the main window but listed after the file 
details is the full pathname for each file.    All copy, move, delete, view, compress, drag and drop 
operations can be performed on the files in the secondary window.    
Two options that the secondary window has that the main window doesn't have is sorting the files by path 
and displaying just the duplicate files.
By default, there is a Dupes button on the secondary window toolbar.    Clicking on this button will display 
only the duplicate files in the listing.    The legend in the lower left of the window will say Duplicate Files.    
Clicking on the Dupes button again will redisplay all the files.    The legend on the lower left will then 
display All Files.



Listing All Files
The list all files command also displays the files in the secondary window.    Choosing List All Files will 
bring up the following dialog box:

List All Files dialog box

From the dialog box you can choose the drives that you want to view.    The option to toggle on the display
of just duplicate files is also available with this command.



Find Files
When you search for files Drag And File will use the secondary window to display the file listing.



Using the Built-In DOS Command Line
We have licensed a copy of SmilerShell Lite for Drag And File.    SmilerShell Lite is a Lite version of the 
powerful DOS command utility SmilerShell Pro.    You can turn on the display of SmilerShell Lite by 
checking "Show DOS Command Line" on the "Options" menu.    When active, SmilerShell Lite will appear 
as an edit window on the bottom of Drag And File.
SmilerShell Lite supports command history, editing, and search.    It supports clipboard functions (cut, 
copy, paste) when given from the keyboard with the usual commands.    It can run DOS or Windows 
programs, and all useful DOS internal commands



Configuring the DOS Command Line
Choose Settings from the Options menu and then choose the “DOS Commands” tab.    The DOS 
Command Options dialog will appear.

DOS In Window:    You can run most DOS commands with the SmilerShell Lite and can choose to have 
these commands run full screen or in a DOS window.    The default is to run the commands in a DOS 
Window.
Inactive DOS Windows Stay Visible:    This options determines whether the DOS windows will stay 
around or close after DOS commands are run.    If you choose to have the DOS windows stay around you 
can easily close them all at once by pressing Ctrl+Shift+K from the keyboard.
Insert Mode: Use this to toggle between Insert or Overtype mode
Case Sensitive Aliases and Drives to Scan will be grayed out unless you have the pro version of 
SmilerShell.    Bardon Data Systems, producers of SmilerShell Lite, are offering owners of Drag And File a
way to upgrade to SmilerShell Pro, a more powerful version.    SmilerShell Pro lets you create aliases, 
enter more than one DOS command at a time, and change directory very fast, even across multiple 
drives. SmilerShell Pro is available in two versions.    The "built-in" version replaces SmilerShell Lite within
Drag And File with a much more powerful command line.    The standalone version gives you a powerful 
command line as a separate program.



Using the DOS Command Line Utility
Enter any DOS command into the edit field and press enter.    The command will be run in a DOS window. 
You can configure SmilerShell Lite to have the DOS windows stay open at the end of a command so you 
can see the results of the command or you can configure it to close them when the command is done.

By using the up and down arrow keys, you can find any previously-issued command.    If characters are 
typed before using the up and down arrows, only commands beginning with those letters are displayed.    

You can also click on the green arrow button at the right of the DOS Command Line and a dialog box with
the previous commands will come up.    From this dialog you can choose which command to use.

Pressing the Escape key clears the command line.    
SmilerShell Lite will run commands full screen or in a window, depending on what the settings are.    If the 
command starts with a right-bracket character (>) it does the opposite for this one command.    So, for 
example, if the command utility is currently set to run commands full screen and the user starts a 
command with a greater than ">" (example: >dir a:) that one command will run in a window.
Inactive windows can be set to either stick around or go away.    If you enter a command starting with an 
asterisk "*" SmilerShell Lite will behave in the opposite manner for this one command.    So, for example, 
say the DOS window state is currently set to make DOS windows vanish after the command ends and 
you start a command with an asterisk (example: *copy file1 b:).    When that command with the asterisk 
exits its "Inactive" window will be left on the screen.    Inactive DOS windows can be easily closed by 
entering Ctrl+Shift+K.
These asterisk and greater than flags can be combined if they are the first two characters on the line.    
(For example: >*myprog param1 param2 param3)    It doesn't matter which flag comes first.
When a DOS command is entered from SmilerShell, then after that command exits, SmilerShell knows to 
actively grab back the focus.    This allows the user to simply keep typing, just like at the DOS prompt.
The DOS command line utility supports drag-and-drop, so you can select files from Drag And File or any 
other drag and drop server.    When the user drops the files onto the SmilerShell control, their names will 
appear in the edit area.    To save space on its command line, SmilerShell tries to use shorter "relative" 
pathnames when appropriate.



ADVANCED USER FEATURES IN THE PRO VERSION
The enhanced Pro version of the SmilerShell does everything the Lite version does, and in addition 
includes some advanced features.
The Pro DLL supports aliases, and these aliases can have run-time parameters (%1 %2 etc.) like batch 
files.    It can run multiple commands on one line, and unlike everything else in Windows, these 
commands are run synchronously -- the next one doesn't start until the previous one completes.
Put these together and you can create parameterized multi-command aliases, which are in effect a built-in
SmilerShell scripting language.
Another Pro feature is its DC quick-directory-change function.    Rather than typing CD and a long path, 
the user need only type DC and the first few letters of the final directory name, and instantly they are 
taken there.    DC works across multiple drives, so it is not necessary to change drives before using DC to 
change directory.    The user can set which drives DC should be aware of, and when to rebuild its DC 
indexes (useful when dealing with large or volatile configurations, such as on a network). 
There is a flyer offering an upgrade to SmilerShell Pro enclosed with your copy of Drag And File.    You 
can also obtain a copy of SmilerShell Pro from Bardon Data Systems at (510) 526-8470.



Accessing the Windows 95 Shell
When running under Windows 95, Drag And File supports the Right Mouse Button Context menus that 
are part of the Windows 95 shell.    For instance you can right click on a group of tagged files and a menu 
will come up allowing you to perform different operations on the files.    There are also contect menus 
available for drive buttons and directories or folders as they are called in Windows 95.



File Context Menu
When you right click on tagged files the context menu options are:
Open    This is the same as launch.    If you have a particular file type Multi-Associated, it will bring up a 
dialog box with programs to launch.    Otherwise it will launch the file with its associated program
Print    This option will only be available if there is a registered file viewer for the file.    If there is, the 
viewer will be launched and it will print the file.
Quick View    This option will only be availabla if there is a registered viewer for the file.    If Drag And View
is available, it will be launched.    Otherwise.    Windows Quick View will be launched to display the file.
Send To    This option brings up a sub menu from whick you can copy the selected files to floppy diskettes
or send as a fax or mail
Cut    This option copies the selected files to the clipboard.    The original copies are deleted.    You can 
then bring up the context menu for a directory and choose past to copy the files to that directory.
Copy    This option copies the selected files to the clipboard. You can then bring up the context menu for a
directory and choose past to copy the files to that directory.
Create Shortcut    This option creates short cuts for the selected files.
Delete    This option deletes the selected files.
Properties    This option brings up the properties dialogs for the selected files.



Directory Context Menu
When you right click on a particular directory the context menu options are:
Explore    This command will open up a copy of Explorer on the highlighted directory.
Open    This option will open an Explorer winodw displaying the contents of the directory.
Find    Opens up the find dialog box from which you can search for files or specific text.
Sharing    If you’re on a network, you can use this option to modify the sharing parameters of the 
directory.
Send To    Sends the contents of the directory to a floppy diskette, fax or mail program.
Copy    Copies the contents of the directory to the clipboard for later pasting.
Paste    If there are files or directories in the clipboard, you can copy them here with this option.
Create Shortcut    Creates a shortcut for the directory.
Properites    Brings up the properties dialog for the directory.



Drive Context Menu
When you right click on a drive button, the context menu options are
Explore    Opens up a copy of Explorer on the drive.
Open    Opens up an Explorer windows on the drive.
Find Opens up the find dialog box from which you can search for files or specific text.
Sharing If you’re on a network, you can use this option to modify the sharing parameters of the drive.
Format    Brings up a dialog box from which you can format the drive
Copy Disk    If you click on a floppy disk, this option will let you perform a disk copy.
Paste    If there are files or directories in the clipboard you can paste them to the rood directory of this 
drive with this option.
Create Shortcut    This option will create a shortcut to this drive.



Right Button Dragging
With Drag And File you can drag files and directories with the right mouse button from Drag And File to 
the desktop and Explorer and from the desktop and Explorer to Drag And File.    When the files are 
dropped a menu will pop up allowing you to perform the following actions.
Move Here    Moves the selected files and directories here
Copy Here    Copies the selected files and directories here
Create Shortcut Here    Creates shortcuts to the selected files and directories in the drop directory.



Copy Diskette

The Copy Diskette command allows you to make an exact copy of any diskette.    Drag And File does disk
copying in one pass so you don't have to go back and forth between the source and destination disk 
when using the same drive to do the copy.    For best results, use the same size diskette for source and 
destination disks.

Copy Diskette Dialog Box



Label Disk
The Label Disk command allows you to change the volume label of a diskette or local hard drive.    Drag 
And File dilsplays the volume label on the right side of the drive window.

Drag And File Drive Window and Volume Label



Managing Archives With Drag And File Gold
Combine Drag And File version 2 or greater with Drag And Zip version 1.4 or later and you have Drag And
File Gold.    With Drag And File Gold all your archive management can be performed from within Drag And
File.



Creating an Archive
To create an archive just tag the files or directories that you want to archive and choose “Create Archive” 
from the archive menu.    There is also a Zip button that you can add to the toolbar that will have the same
action.    Alternately, you can right click on the tagged files or directories and choose “Drag And Zip” from 
the context menu.

The Create Archive dialog will appear:

Create Archive Dialog

Zip Filename:    In this field enter the name of the Archive file that you want to create.    Drag And Zip can 
create PKZIP 2.04g compatible zip files with its built-in zipping.    You can also use an external copy of 
PKZIP or LHA.    
Output Directory: Enter the drive and directory where you want to create the zip file.    There is a 
Browse button to help you find it.
Add
This will create a new zip file or add files to an existing zip file.
Freshen
This will only replace files in an existing zip file with those selected files that are newer than the files in the
zip file.
Update
This is like Freshen but in addition to replacing existing files with newer files, it will also add the files that 
aren't already in the zip file.
Move Files
This option will delete the original files after they are placed in the zip file.    This option is useful when you



want to make more space on your hard disk by zipping files.    Files deleted this way will not go to the 
recycle bin.
Zip Subdirectories
This is equivalent to the "-r" argument with PKZIP.    When you choose this option, Drag And Zip will not 
only zip the files in the directories that you dragged to it, it will zip any sub directories that are in the 
directories and any sub directories in the sub directories, compressing all the files in the directory branch.
Store Pathnames in Subdirectories
This choice is equivalent to the "-p" option in PKZIP.    This option won't save path names of the files in the
directories that you dragged, but it will save the path names of the files in the sub directories of the 
directories that you dragged.    This option won't be available if you are using LHA.
Store All Pathnames
This option will save the path names of every file that you are zipping.

When you are finished, click on the Create Zip button and your zip file will be created.

Save Set
This is a new feature in Drag And Zip where you can save the list of files that you are zipping and the 
other parameters into a Zip Set file.    This is convenient if you frequently create the same zip files for 
backup purposes.    This option will save all the zip parameters into a “.DZZ” file.    Then you can 
automatically recreate the zip file by just double clicking on the DZZ file.    You can also run Drag And Zip 
in batch files with an at sign ‘@’ and the DZZ file to automate the zip file creation.    This DZZ file is text 
based like an INI file.    We have documented the Zip Set format so that other programs can create the 
DZZ file than then run Drag And Zip to create the zip file.

There are 2 additional tabs in the Create Archive Dialog where you can further modify the zip file 
parameters.



Zip Settings Dialog

Archiver
· Built-in Zip    This option will create a PKZIP version 2.04G compatible zip file.    

· PKZIP. This will cause Drag And Zip to run your copy of PKZIP 

· LHA.    This will cause Drag And Zip to run your copy of LHA.
Compression
Use the slider to go from no compression to maximum compression.
DOS Compatibility
Drag And Zip can create zip files with long file names, long directory names and names in mixed case but
you might have trouble extracting these files under DOS or Windows 3.1x which does not support long 
and mixed case names.    If you need to create a zip file for a DOS environment, you can use the options   
Use Short Names and Uppercase File Names.
Make Self Extracting File (EXE)
PKZIP and LHA allow you to make self extracting files.    These files have an EXE extension instead of 
ZIP or LZH.    In addition Drag And Zip allows you to make Windows based self-extracting Zip files.    
These Windows based self-extracting files are 16 bit and will not support long filenames.
Span Multiple Disks
PKZIP version 2 and Drag And Zip's internal zipping allows you to zip files onto multiple floppy diskettes. 
You select the "Span Multiple Disks" check box to enable this option.    When you are zipping to multiple 
disks, you also can specify if the disks that you are zipping to are to be formatted or just erased, and you 
can specify if they are high density or low density.    You can choose any of these options from the drop-
down combo box which becomes active when you check the "Span Multiple Disks" box.
Password Protect



If you are making a Zip file you can also encrypt it so that you need a password to extract files from it.    
When unzipping the file, Drag And Zip will ask you for the password before unzipping it.    Use this option 
with caution because if you loose the password you won’t be able to unzip the file.    This option is the 
same as the -s option when using PKZIP.
Command Line Arguments
If you are using the external archive programs PKZIP or LHA the command line arguments field will be 
available.    In this field you can enter any PKZIP or LHA command line argument.    If you are unfamiliar 
with the argument needed to select a special option you can click on the help button and you'll find a 
complete command line reference in the help file.

Global Settings Dialog

Output Directory
You have two choices for the default output directory that Drag And Zip will enter into the zip dialogs.    
One is the current directory, which is the directory that you dragged the files from.    The other is the 
directory that you used the last time that you used Drag And Zip.
PKZIP Version 2 or Greater
It's important that this option be checked if you are running with PKZIP version 2.04, and that it not be 
checked if you are running with PKZIP version 1.1.    That way Drag And Zip can pass the proper 
commands to PKZIP when it is running it.    No other versions of PKZIP are currently supported.    When 
you choose your PKZIP directory, Drag And Zip will try to determine this automatically.
PKZIP Location
This should contain the directory where your copies of PKZIP and PKUNZIP are.    It is not necessary to 
fill this out if you are using the built-in zipping and unzipping.    You will need to fill this out if you want to 
make self-extracting zip files and ZIP2EXE is not on your path.    When this field is active, you can use the



browse button to find the PKZIP directory.
LHA Location
This should contain the directory where your copy of LHA.EXE is. When this field is active, you can use 
the browse button to find the LHA directory.
Path For Temporary Files
Drag And Zip normally creates temporary files and temporary directories in it home directory.    This may 
not be possible if you are running Drag And Zip from a network and you don’t have write access to the DZ
home directory.    For conditions like this, you can specify a directory where Drag And Zip can store 
temporary files.
Save Settings
Your settings will be saved automatically when you create an archive.    If you don’t want to create an 
archive and just want to save your settings, choose this option and then choose the close button from the 
bottom of the dialog box.
Icon Always Visible
This option will only be available under Windows NT with Program Manager.    Checking this option will 
make Drag And Zip's icon visible at all times.    This is not necessary if you are running Drag And Zip with 
Fileman Launcher, as Fileman Launcher will always uncover DZ's icon when you are working in your file 
manager.
Icon Stays Where Last Put
This option will only be available under Windows NT with Program Manager.    Checking this option will 
have Drag And Zip remember the position of its icon when you last ran it.    This is not necessary if you 
are running DZ with Fileman Launcher
Icon caption
This option will only be available under Windows NT with Program Manager.    Many users have asked if 
they could shorten or eliminate the caption under the Drag And Zip icon when it is running.    Now you can.
Just enter whatever you want in this field and it will appear below Drag And Zip's icon when you run it.    
Unfortunately, if you choose to make this field blank, Windows will put a blank line under the icon rather 
than not having a caption at all.



Zip Backup Sets
Drag And Zip allows you to create Zip backup sets to completely automate making zip files.    You create a
Zip Set from the Zip dialog box.    Choose the zip parameters that you want and then choose Save Set.    
Drag And Zip will save the Zip Set in a DZZ file.    This file will have a list of the files that you want to zip 
plus all of the zip parameters. Zip Sets can only use built-in zipping and cannot make self extracting zip 
files.

Once a zip set is created, you can double click on the DZZ file to automatically recreate the zip file.    Or 
you can run Drag And Zip with the DZZ file as a command line argument with an at sign ‘@’ in front of it.    
Like “DZ32 @ZIPSET.DZZ”.

The DZZ format is text based so other programs can easily create one and then run Drag And Zip to 
create the zip file.

Zip Backup Set Format
The Zip Backup Set format is very similar to a Windows INI file so it is easy to understand and easy for a 
user to create one.

The set consists of two headings: FileList and ZipOptions.

Under the FileList heading you list the files to be zipped each on a new line with there complete paths like
this:

[FileList]
C:\WINWORD\DOCS\DOC1.DOC
C:\WINWORD\DOCS\LETTER.DOC
C:\PROGRAM FILES\DRAG AND ZIP\ZIPFILE.TXT

The FileList section can be 16k bytes long.

The Zip options section contains the zip file name and the way you want the zip file made.

Here is a sample ZipOptions section:
In the example and documentation below the choices are presented in uppercase.    This is just done for 
consistency in the example.    The choices can be either in upper or lower case.

[ZipOptions]
zipfile=C:\ZIPFILES\MYZIP
compression=NONE
action=ADD
recursedirs=NO
storerecurse=NO
storepaths=NO
move=NO
multidisk=FORMATLOW
encrypt=NO
password=
dosnames=NO
uppercase=NO

zipfile This field contains the name of the resulting zip file.    This is the only field that is necessary.    The
other fields are optional and have defaults if they are not included in the DZZ files.
compression Choices are NORMAL, NONE and MAX.    If this field is not included the default in 



NORMAL
action    Choices are ADD, UPDATE and FRESHEN.    These are the same as the PKZIP versions of 
these options.    If this field is left out the default is ADD.
recursedirs Choices are YES and NO.    Default is NO.    This option is like the -r option in PKZIP and 
will zip all the subdirectories of a directory in the FileList section.
storerecurse Choices are YES and NO.    If YES, then recursdirs must be yes too.    This option is like 
the -p option in PKZIP and will store the names of the directories recursed into.
storepaths Choices are YES and NO.    If storerecures isn’t chosen this option will store paths of all the
files zipped and not just the ones in directories recursed into.    This is like the -P option in PKZIP.
multidisk Choices are:
DONTFORMAT:    Just zip the files to the disk.
FORMAT: Format the disk first.
FORMATLOW: Format the disk as a low density disk.
WIPE: Removes all data from the disk so that it can’t be restored with an undelete program.
move Choices are YES and NO.    A yes will move the files.    Default for this option is NO.
multidisk Choices are NONE, FORMAT, FORMATLOW and WIPEDISK.    These are the same as the 
PKZIP functions of the same name.    The default for this option is NONE.
encrypt Choices are YES and NO.    This is the same as the -s option in PKZIP and will create a zip file 
that needs a password to unzip.    Default for this option is NO.
password  If encrypt is YES, then this field will hold the password to zip the file with.
dossnames Choices are YES and NO.    A YES converts long file names and directory names to their 
short DOS counterparts.    This is good if you will be unzipping the file in DOS or Windows 3.1.    Default is
NO.
uppercase Choices are YES and NO.    A YES here will force all file and directory names in the zip file 
to be in upper case.    This option is provided to make the zip file compatible with DOS and Windows 3.1.   
The default for this option is NO.



Working With Archives

Drag And File Gold shows files with ZIP, GZ and TAR extensions as folders.    Unlike the yellow colored 
folders that represent directories, these folders are blue to let you know that they represent archive files.    
When you highlight an archive folder, the contents of the archive appears in the file pane.    If you have the
file pane set to show all details, you will see the amount of compression and an embedded path besides 
the other file details.    You can turn off the Zips as Folders options from the settings dialog.

Extracting files from an archive is the same as moving and copying files to a folder. First tag the files that 
you want to extract.    You can quickly tag all the files by entering Ctrl+A or Ctrl+Right Arrow.    Then 
choose Move or Copy, pick a destination directory and choose OK.    Drag And File will extract the files 
from the archive and place them in the destination directory.    

Deleting files is the same. Tag the files that you want to delete from the archive and choose delete.

Note: Files moved or deleted from archives will not be placed in the recycle bin.

Scan Archive
You can scan archives for viruses by choosing Scan Archive from the Archive menu.    Drag And Zip has a
built-in version of the Integrity Master virus scanner licensed from Stiller Research.    You can also scan 
files with your copy of Scan 95 or Norton Anti Virus.    To pick the scanner that you want to use, go to the 
Drag And Zip tab in the settings menu.
Check Out
Check out is good for those of you who download files from BBSs and then want to quickly try them out to
see if you like them or not.    Normally you would have to first extract the files and then run the installation 
program.    If you didn't like the program you would then have to delete it manually.    Check Out will do all 
of that automatically for you.    Check Out temporarily unzips a file and puts the extracted files in a "Check 
Out" program group so you can "Check them out".    When you're all done you can delete the extracted 
files and the "Check Out" group automatically, or if you want to keep the group, you can save it under 
another name.    
There is also an option to scan the files for viruses before putting them in a program group.




